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Copyrights and Trademarks
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1
Program Overview

This section gives you a brief overview of the program and defin-
itions of terms used in this manual.

Welcome to Expert’s Clip Art 3-D!
Expert’s Clip Art 3-D collection contains 500 images to spruce up all of your documents! Use these images in

virtually all of your favorite word processing and page layout programs. Customize your documents with these

beautiful images that are organized in separate category libraries. Choose anything from plants and animals to

household furniture.

Special Features
View your images in high color and shadowed format. Each piece of clip art contains both formats.

Copy your image into your favorite word processing, paint or presentation program.

Export your images as bmp’s with a simple “Export” procedure.

Choose from 500 images.

The easy-to-use image browser lets you view all of the items for a given category. Simply drag-n-drop the
image you want onto your screen.
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Terms / Definitions
Click Press and release the mouse button (usually the left mouse button unless otherwise specified).

Double-Click Quickly press and release the mouse button twice.

Choose Highlight an item on the menu or dialog box to initiate an action or command, then press the Enter
key or double-click your left mouse button.

Enter Press the Enter or Return key.

Select Mark or choose an item so that the next action or command is carried out on that item. Highlight an
option or choice from the menu or design document by clicking on it.

Drag and Drop Press and hold the mouse button and the shift key down while dragging the mouse. This
allows you to move selected objects.

Choose File—Open Choose a command from the applicable menu item. In this case, the command means to
go to the File menu and select the Open command.

Control Menu Box The hyphen-shaped icon at the top left of the title bar of any window.

Ctrl+Click Pressing and releasing the mouse button quickly while holding the control key on the keyboard.

Perspective The angle at which the object is being viewed.

Export To save an image as a BMP file for easy use in other programs.
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Main Interface 
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1. Title Bar - This area displays the name of the program and the file.

2. Menubar - This area contains the main menus of the program.

3. Tools - This area contains the main tools of the program.

4. Browser - The window which is displayed after an image is selected from the File—Open dialog box.You
can easily drag-n-drop any of these images onto the screen to replace the current image.
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2
Tutorial

This section gives you a quick lesson on how to get
started in Clip Art 3-D.

Clip Art 3-D is an easy-to-use program. Follow these simple steps so you can begin incorporating beautiful 3D
images into all of your files.

Step One
Double-click on the Program icon to initialize the program.
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Step Two
The Main screen with the default biplane image appears.
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Step Three
Click on the Open button on the toolbar.

Step Four
The Open dialog box appears. Double-click on the Animals folder and select the elephant image.
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Step Five
The Browser window appears displaying all of the images in the Animals folder. Even though you selected
elephant, you can choose to view any of the images contained in the browser.
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Step Six
Click, drag-n-drop the elephant image from the browser to the main screen. A dialog box appears asking if you
want to change the current image, select OK.

Step Seven
To change the image’s perspective is easy. Simply click and drag the part of the image you want to rotate. This
takes some getting use to, so play around with this feature for a while.
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Step Eight
Now click on the Export button.

Step Nine
The Export dialog box appears.You may only export as a BMP, so simply name your image and select the
directory you would like it saved to.
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3
Tools/Toolbar

This section defines the program’s tools.

Tools

New button - This tool is used to create a blank screen.
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Open button - Use this tool to open the image browser. The Open File dialog box appears.You can choose
from a list of categories to view.

3DCLIP.QXD  9/17/96 10:39 PM  Page 15



Export button - Launches the Export dialog box. Name the image and it is saved as a BMP file, for easy use
in any other program.
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Print button - Click on this button to print the currently open image. This dialog box appears:
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Copy button - Copies the opened image to the clipboard, where it can be pasted into other programs.

Shadowed Color button - Displays shadowed image

High-Resolution button - Displays pasted images.

Help button - Launches the on-line help file.

Exit button - Exits the program.
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4
Menus

This section defines all menus and their correspond-
ing options.

File Menu

The File Menu lets you control file and printing operations. It includes commands that open,
create, and save design documents.

New (Ctrl + N) 
This menu option is used to create a blank screen to paste images on.
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Open 
Opens an existing file. This menu option is used to choose from a list of clip art categories to be viewed in the
browser.
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Expor t

Used to save the current image as a BMP file.

1. Select the drive and the directory where you wish to save your image.

2. Select a Save File as Type. The default extension for Clip Art 3-D is *.BMP.

3. Enter a name for your untitled image in the File Name box. Remember, the file name must have no more
than eight letters or numbers and no blank spaces. Only letters and numbers are permitted.

4. When you are finished, click on the OK button.
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Print (Ctrl-P)

Choose this option to print the currently selected document. The Print dialog box for the currently active printer
appears. It allows you to print more than one copy. Click on the OK button to print.
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Exit (Alt-F4)
To quit the program and close all document windows, choose File—Exit . If any documents were changed, it
prompts you to save the file(s) before the program quits.
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Edit Menu
The Edit Menu lets you use the clipboard to copy the current object. The Clipboard is a temporary storage
location held and maintained in memory by Windows.

Cut (Ctrl+X)
Use this option to cut an image. Use Edit—Paste to place it in another application.

Copy (Ctrl+C)
To copy an object from your design and place it on the clipboard, choose Edit—Copy . The original remains in
your document.

Paste
You may use the Paste command to copy a duplicate into the current document or another document window.
Once you have copied something onto the clipboard, you can repeatedly paste the last item placed on the clip-
board.
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Display Menu
The Display Menu lets you change the way the current image is being viewed.

Displa y High Color s
Displays the current image in shadowed colors.

Displa y Pasted Ima ges
Displays the images that have been pasted. The images are shown in high-resolution colors.
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Help Menu 
The Help Menu provides access the Clip Art 3-D online help, as well as information about the program.

Contents
Displays the main contents screen of the help file.

About Clip Ar t 3-D
Displays the Clip Art 3-D about box.
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5
Frequently Asked Questions

Get answers to common questions.

Q/A
Q: How do I change the image that is currently being displayed?

A: Click on the Open button and select a category to display. Once the browser window displays that category,
drag and drop the image you want onto the screen.

Q: Can I place more than one image on the screen at a time?

A: No, only one image may be seen on the screen at a time.

Q: How do I change the perspective of an image?

A: Simply click and drag any part of the image around the screen. This feature takes some getting used to, so
play with it for a while.

Q: Can I export my images in texture and color?

A: Yes, which ever feature is being displayed  i.e., texture or color, that is the way the image is exported.
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6
Color Resolution

This section explains how to change your color
resolution.

Changing Your Color Resolution
If you are running in 256-color mode, you may get the message below:

“Clip Art 3-D appears best when using 32000 or more colors. For best performance, change your Display set-
tings to use 16-bit color mode (65000colors).”

To change your Color Resolution:

1. Select Start on your task bar and choose Settings—Control Panel . The control panel program group
appears.

2. Double-click on the Display icon.

3. Choose the Settings tab.

4. In the Color Palette list box, choose High Color (16 bit).

5. Click on OK.

Your computer settings will now be adjusted to 64,000 (16 bit color) color mode.

Note: It is not necessary to change your Color Resolution every time you launch Clip Art 3-D. Once you’ve
selected the 64,000 (16 bit) color mode as your color resolution, Windows 95 saves your color settings until
you change it again.
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Also if you do not have the
64,000 (16 bit) color mode
available, the Clip Art 3-D
engine will not be affected.
This just means you need a
higher-quality video card.
You will still be able to use
all of the other features.
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7
Win32S 

This section details how to remove Win32S when running
Windows 3.1.

Removing Win32S Under Windows 3.1
Warning: IF YOU REMOVE WIN32S v1.30,YOU WILL NO LONGER BE ABLE TO RUN 

APPLICATIONS THAT REQUIRE WIN32S.

If for some reason you like to remove the WIN32S v1.30 files from your system, do the following:

1. Remove the following line from the [386Enh] section in the SYSTEM.INI file:

device=<WINDOWS>\<SYSTEM>\win32s\w32s.386

where <WINDOWS> and <SYSTEM> are the locations of the Windows and System directories, respectively.

2. Remove winmm16.dll from the following line in the [BOOT] section of the SYSTEM.INI file:

drivers=mmsystem.dll winmm16.dll

The line should look like this when you are done:

drivers=mmsystem.dll

3. Delete the following files from the <WINDOWS>\<SYSTEM> directory:

W32SYS.DLL WIN32S16.DLL WIN32S.INI Winhlp32.cnt

Windows.hlp Winhlp32.hlp Winhlp32.exe

4. Delete all of the files in the <WINDOWS>\<SYSTEM>\WIN32S directory,

then delete the subdirectory itself.

5. Restart Windows.
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Expert Software License Statement Expert Software License Statement 
This software is protected by both United States Copyright Law and International Treaty provisions. Expert Software, Inc. grants you this license
and your continued use confirms your agreement. Therefore, you must treat the software “just like a book,” with the following single exception:
Expert Software, Inc. authorizes you to make archival copies of the software for the sole purpose of backing up your software and protecting your
investment from loss.
By saying “just like a book,” Expert Software, Inc. means, for example, that the software may be used by any number of people and may be freely
moved from one computer to another, so long as there is no possibility of being used at one location while it’s being used in another. This is just
like a book that cannot be read by two different people in two different places at the same time; neither can this software be used by two different
people in two different places at the same time.
This agreement shall be construed, interpreted, and governed by the laws of the state of Florida and shall inure to the benefit of Expert Software,
Inc. its successors, administrators, heirs, and assigns. 

u 

u Limited WLimited Warrantyarranty
Limited warranty on product disks. To the original buyer only, Expert Software, Inc. warrants the disk or disks on which this product is recorded
to be free of defects in material and workmanship under normal use for a period of 90 days from the purchase date. Any implied warranties of mer-
chantability or fitness for a particular purpose are limited in duration to the period of 90 days from the date of purchase. Your sole and exclusive
remedy in the event of a defect in material or workmanship under normal use is expressly limited to replacement of the defective item.
This warranty gives you specific legal rights, and you might also have other rights which vary from state to state.
No warranty on product software or User’s Guide. Even though Expert Software, Inc. has tested the software and User’s Guide and reviewed their
contents, Expert Software, Inc. and its distributors and dealers make no warranties, either expressed or implied, with respect to the fitness for a
particular purpose. The software and User’s Guide are distributed solely on an as is basis. The entire risk as to their quality and performance is
with you. Should either the software or User’s Guide or both prove defective, you (and not Expert Software, Inc. and its distributors and dealers)
assume the entire cost of all necessary servicing, repair, or correction. Expert Software, Inc. and its distributors and dealer will not be liable for
direct, indirect, incidental, or consequential damages resulting from any defects in the software or User’s Guide, even if they have been advised of
the possibility of such damages.
Some states do not allow limitations on how long an implied warranty lasts or the exclusion or limitation of incidental or consequential damages,
so the above limitations or exclusions might not apply to you.

u 

u CopyrightCopyright
© 1996 Expert Software, Inc. All Rights Reserved.  All Rights Reserved Worldwide. The user’s guide and the software described in it are copy-
righted with all rights reserved. The user’s guide or software may not be copied in whole or part, without written consent of Expert Software, Inc.
You may not sell, rent, lease or transfer copies of the user’s guide or software in any other way without the prior written consent of Expert Software,
Inc.

u 

u TTrademarksrademarks
Expert Software and the Expert brand logo are trademarks of Expert Software, Inc. Microsoft and Windows are registered trademarks of Microsoft
Corporation. Macintosh is a registered trademark of Apple Computer Inc. All other trademarks are acknowledged.
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Product SupportProduct Support
Your purchase of an Expert product includes free product support to help you get the most out of your software. All Expert products are thoroughly
tested and come with a Help File, User’s Guide and/or Online Manual. In most cases, the answers to many of your questions are in the Help File,
User’s Guide and/or Online Manual. If you are having problems starting or running the program, please feel free to contact us. 

24 Hour Automated Support24 Hour Automated Support
u  u  Find answers to frequently asked questions on the worldwide web at http://www.expertsoftware.com
u  u  Use our Fax Back System for support and product information at (800) 772-5706. 

E-mail AddressesE-mail Addresses
u  u  You can send e-mail to support@expertsoftware.com or sales@expertsoftware.com

Mailing AddressMailing Address
800 Douglas Road, Suite 750, Coral Gables, FL 33134 or P.O. Box 144506, Coral Gables, FL 33114-4506.

TTelephone Product Supportelephone Product Support
(  Contact a friendly Expert Product Support Specialist Monday through Friday, 9:00AM to 5:00PM EST, (Eastern Standard Time). 

u  u  Telephone (305) 567-9996
u  u  Fax (305) 569-1350.

If you call, you should be at your computer. Be ready to give the Product Support Specialist the 10-digit program version number from the front of
your program disk or back of the CD jewel case, as well as the following information:
u  u  If you have a Macintosh®–compatible computer:

u  u  Please have the model, system software version and amount of memory available.
u  u  If you have a Windows®– or MS-DOS®–compatible computer:

u  u  The version of DOS that is installed on your computer. (You can determine the version by typing VER at the DOS prompt.)
u  u  The version of Windows® installed on your computer.
u  u  The type of hardware you are using:
u  u  The brand of computer you own, 
u  u  CPU type (80386, 80486, Pentium®), 
u  u  Video type (EGA, VGA, Super VGA),
u  u  Model and type of video card, and 
u  u  Model and type of printer.
u  u  The exact wording of any messages that appeared on the screen.
u  u  What happened and what you were doing when the problem occurred.
u  u  We encourage Windows® 3.x (or MS-DOS 6.x) users who need product support to print an MSD report. Have it available for the 

Product Support Specialist who answers your call. You will find the MSD (Microsoft Diagnostics) program in either the Windows or 
the DOS directory.

3DCLIP.QXD  9/17/96 10:39 PM  Page 33


	Clip Art 3-D
	Credits
	Copyrights and Trademarks

	Program Overview
	Welcome to Expert’s Clip Art 3-D!
	Special Features
	Terms / Definitions
	Main Interface

	Tutorial
	Step One
	Step Two
	Step Three
	Step Four
	Step Five
	Step Six
	Step Seven
	Step Eight
	Step Nine

	Tools/Toolbar
	Tools

	Menus
	File Menu
	New (Ctrl + N)
	Open (Ctrl+O)
	Export (Ctrl+S)
	Print (Ctrl P)
	Exit (Ctrl+Q)

	Edit Menu
	Cut (Ctrl+X)
	Copy (Ctrl+C)
	Paste (Ctrl+V)

	Display Menu
	Display High Color
	Display Pasted Images

	Help Menu
	Contents
	About Clip Art 3-D


	Frequently Asked Questions
	Q/A

	Color Resolution
	Changing Your Color Resolution

	Win32S
	Removing Win32S Under Windows 3.1

	Expert Software License Statement Expert Software License Statement
	Product Support Product Support
	Index

